
   

 

 

 

 

  

 

1 www.xsens.com 

 
 

 

 

 

 

 
 

 
 
 

 

 
MT Manager User Manual 

 

 For all MT devices 

Document MT0605P, Revision 2019.B, Nov 2019 
 



   

 

 

 

 

  

 

2 www.xsens.com 

 

 

Revision Date By Changes 

A 1 Apr 2008 MMI Initial release 

    

R1 14 Dec 2017 MHA Added mention about Config Mode after 

closing MT Manager 

2018.A 25 June 2018 SGI Added information about MTi-7 

2019.A 11 Jan 2019 SGI Updated for release of MTSS v2019.0, 

added NMEA output message parser 

2019.B Nov 2019 AKO Xsens Brand Update 

    

 

 
© 2005-2020, Xsens Technologies B.V. All rights reserved. Information in this document is subject to change 
without notice. Xsens, Xsens DOT, MVN, MotionGrid, MTi, MTi-G, MTx, MTw, Awinda and KiC are registered 
trademarks or trademarks of Xsens Technologies B.V. and/or its parent, subsidiaries and/or affiliates in The 
Netherlands, the USA and/or other countries. All other trademarks are the property of their respective owners. 

 

  



   

 

 

 

 

  

 

3 www.xsens.com 

Table of Contents 

1 Terms, abbreviations and references ........................................ 8 

2 Xsens Help Center and User Community ................................... 9 

3 Introduction ............................................................................ 10 

4 Quick start .............................................................................. 11 

4.1 Installing the MT Manager .......................................................................... 11 

4.2 Connecting your device to MT Manager ........................................................ 12 
4.2.1 Automatic COM port selection ................................................................ 12 
4.2.2 Manual COM port selection .................................................................... 13 

4.3 Basic functionality of MT Manager ................................................................ 14 
4.3.1 Configuring Motion Tracker ................................................................... 14 
4.3.2 Recording data .................................................................................... 16 
4.3.3 Opening the file and playback data ........................................................ 17 
4.3.4 Exporting a file to ASCII ....................................................................... 18 

5 Overview MT Manager ............................................................. 20 

5.1 Purpose .................................................................................................... 20 

5.2 MT Manager features ................................................................................. 20 

5.3 Supported devices ..................................................................................... 20 

5.4 Input Options ............................................................................................ 20 

5.5 Output Files .............................................................................................. 21 

5.6 Menu bar .................................................................................................. 22 

5.7 Data views, toolbars and buttons ................................................................ 24 
5.7.1 The Device List .................................................................................... 24 
5.7.2 Device Settings ................................................................................... 25 
5.7.3 Data Views .......................................................................................... 26 
5.7.4 Connectivity ........................................................................................ 40 
5.7.5 File control .......................................................................................... 40 
5.7.6 Playback & recording ............................................................................ 40 
5.7.7 Orientation resets ................................................................................ 41 
5.7.8 In-run Compass Calibration & Representative Motion ............................... 42 
5.7.9 Manual Gyro Bias Estimation ................................................................. 42 

6 Operating guidelines ............................................................... 44 

6.1 Overview .................................................................................................. 44 

6.2 Configuring the MT Manager and your devices .............................................. 44 
6.2.1 General settings .................................................................................. 44 
6.2.2 Using the Device Settings window .......................................................... 44 



   

 

 

 

 

  

 

4 www.xsens.com 

6.3 Using the Device/XDA Data View terminals ................................................... 60 
6.3.1 Device Data View ................................................................................. 60 
6.3.2 XDA Data View .................................................................................... 67 

6.4 Typical utilisations ..................................................................................... 68 
6.4.1 Logging data ....................................................................................... 69 
6.4.2 Replaying logged data .......................................................................... 69 
6.4.3 Exporting ASCII data ............................................................................ 73 
6.4.4 Exporting KMZ data.............................................................................. 80 
6.4.5 Using multiple MTis .............................................................................. 81 

7 System requirements .............................................................. 83 

 

List of Tables 
 

Table 1: MTi product documentation overview ........................................................... 9 
Table 1: Playback and plotting options .................................................................... 17 
Table 2: The MT Manager menu structure ................................................................ 22 
Table 3: The data shown in the Device List .............................................................. 24 
Table 4: The MT System State shown in the Device List ............................................ 24 
Table 5: The line colours in the inertial data graph.................................................... 28 
Table 6: The different scaling options in the graph windows. ...................................... 28 
Table 7: Colours in the Euler angles graph ............................................................... 32 
Table 8: Colours in the quaternion graph ................................................................. 33 
Table 9: Signals in the Status window ..................................................................... 35 
Table 10: Colours used in the SV information window ............................................... 38 
Table 11: Meaning of buttons in the File Control toolbar ............................................ 40 
Table 12: Meaning of the buttons in the Playback and Recording toolbar ..................... 41 
Table 13: The available orientation resets ................................................................ 41 
Table 14: Explanation of the information in the header of the Device Settings window .. 45 
Table 15: The information displayed in the Deveice Settings tab................................. 47 
Table 16: The modes in the Output Configuration window ......................................... 48 
Table 17: Buttons in the Output Configuration window .............................................. 50 
Table 18: List of available synchronization functions ................................................. 53 
Table 19: Synchronization options of the Trigger Indication function ........................... 54 
Table 20: List of options for Send Latest synchronization functionality ......................... 54 
Table 21: List of options for Interval Transition Measurement (SyncOut) functionality ... 56 
Table 22: List of options for Clock Bias Estimation synchronization functionality ........... 57 
Table 23: Functions available in the Device Data Viewer ............................................ 61 
Table 24: The options in the menu in the Device Data Viewer after right-clicking the data.

 .......................................................................................................................... 63 
Table 25: Parameters shown when data is being processed from a file ........................ 71 
Table 26: Parameters that can be chosen to automatically form a file name for the ASCII 

exporter .............................................................................................................. 74 
Table 27: Overview of all possible exported columns in an ASCII file ........................... 76 
 



   

 

 

 

 

  

 

5 www.xsens.com 

List of Figures 
Figure 2: The installation procedure is straightforward. In the second screen, you can 

choose to skip installation of several components (not recommended) ........................ 11 
Figure 3: MT Manager scanning for attached devices ................................................. 12 
Figure 4: The main screen of MT Manager with an MTi-300 attached via USB ............... 13 
Figure 5: The connectivity toolbar .......................................................................... 13 
Figure 6: Manually selecting the COM port that MT Manager uses during its scanning 

procedure ............................................................................................................ 13 
Figure 7: Manually selecting the baud rate that MT Manager uses during its scanning 

procedure ............................................................................................................ 14 
Figure 8: MT Manager showing the MTi-300 with DeviceID 03782083 in the Device List 15 
Figure 9: The Output Configuration windows features easy to use presets. .................. 15 
Figure 10: The header of the Device Settings window shows general information on the 

MTi ..................................................................................................................... 16 
Figure 11: A typical view of MT Manager ................................................................. 16 
Figure 12: After opening a file with MT Manager, a window is shown when orientation is 

not available in the file. ......................................................................................... 17 
Figure 13: The Playback toolbar ............................................................................. 17 
Figure 14: The Graphs options in the Tools - Preferences window ............................... 18 
Figure 15: The Preferences – ASCII Exporter window ................................................ 19 
Figure 16: The menu bar in MT Manager ................................................................. 22 
Figure 17: The Device List ..................................................................................... 24 
Figure 18: Right-click on the Device allows to disconnect a single MT .......................... 25 
Figure 19: the Output Configuration tab for an MTi-G-710 GNSS/INS. Depending on the 

MTi attached, the Output Configuration window may show fewer options. .................... 26 
Figure 20: The Data Views and GNSS toolbars ......................................................... 26 
Figure 21: The 3D Box view is an easy way of visualizing the orientation of any MTi ..... 27 
Figure 22: The Inertial data view for acceleration, angular velocity and magnetic field .. 28 
Figure 23: Tools let you configure the graphs ........................................................... 28 
Figure 24: A zoom rectangle in the Euler angles graph .............................................. 29 
Figure 25: Zooming in y-direction only can be enabled with the button "show all samples"

 .......................................................................................................................... 30 
Figure 26: Panning is available in all directions ......................................................... 30 
Figure 27: The Show Values button activates the possibility to see the values in the 

graph .................................................................................................................. 31 
Figure 28: Turning off some of the channels allows for closer investigation of a particular 

signal .................................................................................................................. 31 
Figure 29: The orientation graph shows the orientation of the MTi over a period of 10 

seconds ............................................................................................................... 32 
Figure 30: The quaternion graph shows the 4 components in one graph ...................... 33 
Figure 31: Tick boxes for status in the Output Configuration window ........................... 33 
Figure 32: The status window of an MTi-30 AHRS. In this particular screen shot, several 

gyroscopes are clipping ......................................................................................... 34 
Figure 33: The status windows of the MTi-G-710 and MTi-7 have two extra channels, 

GNSS Fix and Filter Mode ...................................................................................... 34 
Figure 34: The Temperature view window, showing that the MTi is warming up directly 

after powering it. .................................................................................................. 35 
Figure 35: The Velocity data view, displaying 3D velocity in m/s ................................ 36 

file:///C:/SVN/Documentation/Motion%20Trackers/MT%20SDK/MT%20Magnetic%20Calibration%20Manual/MT%20Magnetic%20Calibration%20Manual.docx%23_Toc33099335
file:///C:/SVN/Documentation/Motion%20Trackers/MT%20SDK/MT%20Magnetic%20Calibration%20Manual/MT%20Magnetic%20Calibration%20Manual.docx%23_Toc33099335
file:///C:/SVN/Documentation/Motion%20Trackers/MT%20SDK/MT%20Magnetic%20Calibration%20Manual/MT%20Magnetic%20Calibration%20Manual.docx%23_Toc33099345
file:///C:/SVN/Documentation/Motion%20Trackers/MT%20SDK/MT%20Magnetic%20Calibration%20Manual/MT%20Magnetic%20Calibration%20Manual.docx%23_Toc33099345
file:///C:/SVN/Documentation/Motion%20Trackers/MT%20SDK/MT%20Magnetic%20Calibration%20Manual/MT%20Magnetic%20Calibration%20Manual.docx%23_Toc33099353


   

 

 

 

 

  

 

6 www.xsens.com 

Figure 36: The Altitude data view, displaying height above the WGS-84 Ellipsoid in 

meters ................................................................................................................ 37 
Figure 37: The Position view, displaying 2D position ................................................. 37 
Figure 38 The SV info window showing 5 GPS satellites and 6 GLONASS satellites being 

used for the navigation solution and 2 satellites that have been detected. ................... 38 
Figure 39: The UTC Time view. .............................................................................. 39 
Figure 40: The message terminals for the device (left) and XDA (right) ....................... 39 
Figure 41: The messages window may show warnings on e.g. missed data packets ...... 40 
Figure 42: The Connectivity toolbar ........................................................................ 40 
Figure 43: The File control toolbar .......................................................................... 40 
Figure 44: The Playback and recording bar when an MTi is attached (left) and when a file 

is loaded in MT Manager (right) .............................................................................. 40 
Figure 45: The orientation resets toolbar can be used to apply a specific reference 

coordinate system to the MTi's orientation, velocity and sensors data output ............... 41 
Figure 46: Click the Representative Motion button to start the Representative Motion 

mode. Click it again to stop the Representative Motion mode. .................................... 42 
Figure 47: This button stores the ICC parameters in the non-volatile memory .............. 42 
Figure 48: The Manual Gyro Bias Estimation window guides the user through the use of 

the feature. ......................................................................................................... 43 
Figure 49: In the Device Settings window, it is important to write the changes made to 

the MTi................................................................................................................ 44 
Figure 50: The header shows general information on the MTi ..................................... 44 
Figure 51: The modeling parameters show values determined in Xsens' calibration 

procedure ............................................................................................................ 46 
Figure 52: Device settings in the MT Settings dialog show various device-specific settings

 .......................................................................................................................... 48 
Figure 53: The mode can be selected with the radio buttons ...................................... 48 
Figure 54: The Output Configuration window of an MTi-G-710 that is attached to MT 

Manager. When another device is attached, the output configuration window may contain 

fewer options. ...................................................................................................... 49 
Figure 55: String report mode output configuration options ....................................... 49 
Figure 57: The Output Configuration Window of a file that contains data from an MTi-G-

710. All outputs are shown, but cannot be edited. .................................................... 50 
Figure 58: Starting the setup of a synchronization option. ......................................... 52 
Figure 59: Trigger Indication sets a marker in the MTData2 packet when a voltage is read 

on the SyncIn line. The red line represents the voltage on the Sync line ...................... 54 
Figure 60: Send Latest configured as Rising Edge ..................................................... 55 
Figure 61: The Interval Transition Measurement with its default settings. .................... 56 
Figure 62: Clock bias estimation on a clock of 4 Hz. .................................................. 57 
Figure 63: GPS Clock Sync synchronizes the crystal of the MTi and the GPS clock. ........ 58 
Figure 64: Warning that you are about to delete the GPS clock Sync ........................... 58 
Figure 65: With StartSampling, the MTi will only start sending data when a pulse has 

been received ...................................................................................................... 59 
Figure 66: 1 PPS Time pulse in the Synchronization dialog ......................................... 59 
Figure 67: The Sync Options dialog gives a warning when settings are conflicting or 

duplicate ............................................................................................................. 60 
Figure 68: The Device Data View showing data that is being received from the MTi 

device. ................................................................................................................ 61 



   

 

 

 

 

  

 

7 www.xsens.com 

Figure 69: A typical view of received MTData2 messages shown in the Device Data View

 .......................................................................................................................... 62 
Figure 71: Right-clicking on the data in the window shows a menu with options ........... 63 
Figure 72: Composing a message in the Device Data View can be done by selecting a 

message from the "Compose' menu ........................................................................ 64 
Figure 73: Click "edit" to make changes to the message selected from the "Compose" 

menu .................................................................................................................. 64 
Figure 74: After clicking “edit”, the data field from the message can be edited. ............ 65 
Figure 75: Messages showing the acknowledge sequence in the low-level Xbus protocol 66 
Figure 76: An example showing how to request settings from the MTi device. .............. 67 
Figure 77: The XDA message terminal has an extra field with respect to the Device Data 

Viewer, showing the data received from the Xsens Device API (XDA) .......................... 68 
Figure 78: The logging name can be changed in the Preferences window. Use <time> 

and/or <trial> to ensure unique file names .............................................................. 69 
Figure 79: Log files of the MT Manager have an .mtb extension .................................. 70 
Figure 80: When opening an .mtb that contains SDI data, you choose the desired filter 

profile ................................................................................................................. 70 
Figure 81: The file loading screen, displaying relevant information on file .................... 70 
Figure 82: The behaviour of the graphs can be adapted in the Preferences - Graphs 

window ............................................................................................................... 72 
Figure 83: The Playback toolbar ............................................................................. 72 
Figure 84: ASCII exporter settings dialog ................................................................ 73 
Figure 85: In the delimiter options, you can even choose your own exotic delimiter, e.g. 

§ or ¼ ................................................................................................................ 74 
Figure 86: When no data is available in a row, specify your own characters for the empty 

cell/field .............................................................................................................. 75 
Figure 87: Options for data export .......................................................................... 75 
Figure 88: Exported ASCII txt file in Excel. Empty fields are filled with NaN (configurable 

in the Preferences window). ................................................................................... 76 
Figure 89: An MTi-G-710 data point in Google Earth ................................................. 81 
Figure 90: Managing an MTi-300 (left) and an MTi-7 (right) ....................................... 82 
 

  



   

 

 

 

 

  

 

8 www.xsens.com 

1 Terms, abbreviations and references 
 
Term Description 

Quaternion A non-commutative extension of complex numbers. A unit length quaternion is a 
convenient parameterization of rotations. 

Euler Angles Representation of the spatial orientation of any frame of the space as a 

composition of rotations from a reference frame. 

 
Abbreviation Description 

DOF Degrees Of Freedom 

DSP Digital Signal Processor 

GNSS Global Navigation Satellite Systems (GPS, GLONASS, Galileo, BeiDou, QZSS) 

GPS Global Positioning System 

QZSS Quasi-Zenith Satellite System (Japanese Positioning System) 

IMU Inertial Measurement Unit 

KML Keyhole Markup Language 

KMZ Zipped Keyhole Markup Language 

LLA Latitude Longitude Altitude 

MFM Magnetic Field Mapping 

MT Motion Tracker 

MTB MT Binary Communication Protocol 

MTM MT Manager 

OpenGL Open Graphics Library 

SDK Software Development Kit 

SVInfo Space Vehicle Information 

UTC Coordinated Universal Time 

WGS84 The latest revision of the World Geodetic System. It defines a reference frame 
for the earth, for use in geodesy and navigation. 

Xbus Xsens Communication Protocol 

XDA Xsens Device API, the communication API between the MTi and the user 
application. See also [MTi_10s_100s] 

XFF Xsens Firmware File format 

XKF Xsens Kalman Filter 

XEE Xsens Estimation Engine 

XML eXtended Markup Language 

 
Reference id Document description 

[LLCP] “MT Low-Level Communication Protocol Documentation.pdf”, document ID 
MT0101P 

[MFM] “Magnetic Field Mapper Documentation.pdf”, document ID MT0202P 

[FWU] “Firmware Updater User Manual.pdf”, document ID FU0100P 

[MTi_10s_100s] “MTi User Manual.pdf”, document ID MT0605P 

[MTw_SDK] “MTw SDK User Manual.pdf”, document ID MV0319P 

[MTi_1s] “MTi 1-series Data sheet”, document ID MT0512P  

 

 

Note: The latest available documentation can be found in your MT Software Suite 

installation folder or via the following link: https://xsens.com/xsens-mti-documentation 

 

 

https://xsens.com/xsens-mti-documentation
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2 Xsens Help Center and User Community 
Xsens has an extensive help center, a place where users of Xsens and Xsens employees 

(support, field application engineers, sales and R&D engineers) meet. The knowledge 

base contains tips and tricks, guidance and answers to frequently asked questions. News 

is also shared at the knowledge base and it is possible to ask additional questions 

(registration required).  

 

The user community is the place to ask questions. Answers may be given by other users 

or by Xsens employees. The response time in the user community is significantly shorter 

than the response time at Xsens support.  

 

The knowledge base and user community are searchable simultaneously. A search query 

thus shows results irrespective of the source.  

 

Please visit https://base.xsens.com to complete your 1 minute registration. 

 

Table 1 summarizes all available official documents for the Xsens MTi product line.  

 
Table 1: MTi product documentation overview 

MTi 1-series MTi 600-series MTi 10/100-series 

MTi Family Reference Manual 

MTi User Manual 

MTi 1-series Datasheet MTi 600-series Datasheet 

MTi 1-series DK User Manual 
MTi 600-series DK User 

Manual 

MTi 1-series HW Integration 
Manual 

MTi 600-series HW 
Integration Manual 

MT CAN protocol 

Documentation 

MT Manager Manual 

Magnetic Calibration Manual 

MT Low Level Communication Protocol Documentation 

Firmware Updater User Manual 

  

https://base.xsens.com/
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3 Introduction 
This user manual describes the product features and operating instructions for Xsens’ MT 

Manager 2019. 

 

MT Manager is compatible with all Xsens Motion Trackers (for a complete list of supported 

MTs, refer to section 5.3). Note that listed features and sections in this document may 

not apply to all Xsens devices. For device specific details please refer to the 

documentation listed in Section 1. 

 

The MT Manager uses the XsensDeviceApi64.DLL or XsensDeviceApi32.DLL with the 

dynamic library interface. This is the same API that is provided for software development 

in the MT SDK. 

 

The MT Manager software is an easy-to-use software with familiar Windows user 

interface, which allows you to: 

• view 3D orientation in real-time 

• view inertial and magnetic sensor data in real time 

• view latitude, longitude, altitude plots in real time (depends on Motion Tracker used) 

• monitor and compose message to and from the device via a message terminal 

• export log files to other formats like ASCII and KMZ 

• change and view various device settings and properties  

• run a self-test to check the mechanical functions of the inertial sensors and 

magnetometer 

 

The MT Manager is therefore an easy way to get to know and to demonstrate the 

capabilities of the Motion Tracker. 
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4 Quick start 
This section is intended to help you install and use the MT Manager quickly. For detailed 

instructions, please go to sections 5 and 6. 

4.1 Installing the MT Manager 
First you need to install the MT Manager on your computer running Windows 7 or Linux 

(Windows 10 has been tested, but is not officially supported). This is easily done by using 

the MT Software Suite application that guides you through the installation.  

NOTE: the most recent version of the software, source code and documentation can be 

downloaded from the support section of www.xsens.com. 

 

For users of previous Xsens’ MT software: 

Be sure to uninstall the previous version of the USB converter drivers: 

Open the Windows Control Panel and go to Add or Remove Programs. 

Look for the entry 'Windows Driver Package - Xsens USB-serial Converter Driver 

Package'. Please uninstall all entries of these drivers. 

 

For Windows Vista/Windows 7/Windows 8/Windows 10 users: 

Download the installer from https://www.xsens.com/mt-software-suite/. This installation 

procedure also tells the procedure to install the entire MT Software Suite.  

The installation procedure installs several components and starts with the screen as 

shown below: 

 

 
 

 

 

Figure 1: The installation procedure is straightforward. In the second screen, you can choose to skip 
installation of several components (not recommended) 

http://www.xsens.com/
https://www.xsens.com/mt-software-suite/
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4.2 Connecting your device to MT Manager 

Connect a device to your PC using the supplied USB cable. With the USB cable, the MTi 

device is automatically found.  

4.2.1 Automatic COM port selection 

Upon execution of the MT Manager it automatically scans the available COM-ports and/or 

MTi USB devices on the PC for connected devices.  

 

 
Figure 2: MT Manager scanning for attached devices 

If you are using an RS-485 sensor, be sure to enable the RS-485 compatibility mode in 

the General pane via “Tools” → “Options…”, refer to section 5.6. Without RS-485 

compatibility enabled, the RS485 MTi device may not be found.  

 

The MTis are displayed in the Device List with the respective unique MT device ID 

number. 
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Figure 3: The main screen of MT Manager with an MTi-300 attached via USB 

After physically connecting one or more devices, press the rescan button  to let MT 

Manager search for connected devices on any available COM port and update the device 

list. 

When you want to disconnect all devices, press the disconnect button . 

4.2.2 Manual COM port selection 

If you want to select the COM port manually, then in the Connectivity toolbar: 

 

 
Figure 4: The connectivity toolbar 

 

You can choose a COM port and the baud rate if you are using a serial connection or a 

USB converter, see below. Note that the direct USB connection does not have a COM-

port. Instead, the USB has a unique USB name that you can find in the Device Settings 

dialog window, see section 6.2.2.4.  

     

 
Figure 5: Manually selecting the COM port that MT Manager uses during its scanning procedure 



   

 

 

 

 

  

 

14 www.xsens.com 

 
Figure 6: Manually selecting the baud rate that MT Manager uses during its scanning procedure 

For the COM ports you can choose between all active COM ports. It is recommended to 

use the “Auto” baud rate to have the baud rate determined automatically. Then, press 

the “Scan Port” button1 . 

 

To learn how to retrieve the USB name, please refer to section 6.2.2.4.  

 

Now you are ready to go using your Motion Tracker with the MT Manager. 

4.3 Basic functionality of MT Manager 

This section describes how to setup the MTi for recording and exporting data.  

4.3.1 Configuring Motion Tracker 

After the MTi is connected, the MTi should be in the Device List in the bar on the left.  

 
1 If you are using an RS-485 sensor, be sure to enable the “RS-485 compatibility mode” (refer to 
section 4.2.1). 
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Figure 7: MT Manager showing the MTi-300 with DeviceID 03782083 in the Device List 

The first step is to configure the MTi. Open the Device Settings window .  The Output 

Configuration settings tab will be shown. 

 

The default output configuration can be found in [LLCP]. The preset drop down bar allows 

choosing other options. Recording data with the XDA processing preset allows 

reprocessing the file with any compatible filter profile. It is possible to select individual 

data IDs, but note that when orientation is selected, the onboard processed orientation is 

recorded. Files with onboard processed orientation data cannot be reprocessed using a 

different filter profile.   

 

 
Figure 8: The Output Configuration windows features easy to use presets. 

In this step-through, the settings of the MTi other than the output configuration will not 

be changed. It is however possible to change filter settings, configure synchronization 

options or to review the calibration parameters. In the header, it also shows the 

hardware ID, Firmware Revision and other MTi information.  
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Figure 9: The header of the Device Settings window shows general information on the MTi 

 

4.3.2 Recording data 

First check if you receive data. Open for example the 3D view  and the inertial data 

graph .  

 
Figure 10: A typical view of MT Manager 

Press the record button in the menu bar: .  

The record status is shown in the bottom right corner:  

Press the record button again to stop recording.  
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4.3.3 Opening the file and playback data 

Open the file with File – Open,CTRL+O or the Open File icon . When orientation data 

is not in the file, a pop-up window will ask for the required filter profile. When applicable, 

additional processing options can be enabled or disabled by using the check boxes. See 

[MTi_10s_100s] for more information on filter profiles and additional processing options.  

 
You 

can 

now 

playback the file by pressing the Play-button. You can revert to the beginning of the file 

with the Rewind to Start-button.   

 
Figure 12: The Playback toolbar 

Choose to playback data in real-time or at once by changing graph settings in Tools - 

Preferences.  
Table 2: Playback and plotting options 

Parameter Comments 

File plotting Real-time plays data in real-time;  

All Data (as fast as possible) plots all data at once. Note that you 

need to increase the Maximum Display time to see all data;  

All Data (update every 5 sec..) is required when the file is extremely 

large 

Maximum display 

time 

Increase this value to a higher value (File) in order to show more 

data, especially useful when investigating a file.  

Figure 11: After opening a file with MT Manager, a window is shown when orientation is 
not available in the file. 
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Figure 13: The Graphs options in the Tools - Preferences window 

4.3.4 Exporting a file to ASCII 

In order to use the data in other programs, e.g. Excel or MATLAB, the MT Manager allows 

to export the data to a text file. To do so, click open a log file and press the Export 

button . A window will open in which you can elect the data to be exported. When the 

exported data is not available, the field will be filled with the Empty Field option. Click 

Export to generate the ASCII text file. 
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Figure 14: The Preferences – ASCII Exporter window 
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5 Overview MT Manager 
This section describes the options available to the user in the MT Manager.  

In section 6 operating the MT Manager is described.  

5.1 Purpose 
The purpose of the MT Manager is to provide easy access to the capabilities of any of the 

currently supported devices (refer to section 5.3).  

The MT Manager can be used to interface with the MT and to visualize and log data. It 

offers export options for ASCII text files. The ASCII export format can be customised to 

your needs.  

5.2 MT Manager features 
The MT Manager software is an easy-to-use software with a familiar Windows user 

interface, which allows you to: 

• view 3D orientation in real-time 

• view inertial and magnetic sensor data in real time 

• view latitude, longitude, altitude plots in real time (depends on Motion Tracker used)  

• view and compose messages to and from the device via a real time message 

terminal 

• reprocess binary data log files 

• export log files to ASCII 

• change and view various device settings and properties  

• run a self test to check the mechanical functions of the inertial sensors and 

magnetometer 

•  

The MT Manager is therefore an easy way to get to know and to demonstrate the 

capabilities of your Xsens Motion Tracker. 

5.3 Supported devices 
Currently the following devices are being supported by the MT Manager: 

• MTi 1-series 

• MTi 10-series 4th and 5th generation  

• MTi 100-series, including MTi-G-710 GNSS/INS 4th and 5th generation 

• MTw Awinda [MTw_SDK]) 

 

For detailed information about these MTs, please refer to the corresponding User Manuals 

and Technical Documentation: [MTi_1s] and [MTi_10s_100s]. 

Future Xsens Motion Trackers will be supported as of their release. 

5.4 Input Options 
The MT Manager can handle real-time input and input from recorded binary files (see also 

sections 6.4.1 and 6.4.2). 

 

Real-time: Serial data using USB or COM port (via USB virtual COM-port or RS2322).  

 

 
2 COM1 and COM2 only 
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Files: .MTB (MT Binary Communication Protocol)3 log files. Contain recorded 

output log-files from a Motion Tracker.  

 

In both cases the input (file) format is the same. 

 
The .MTB log files generated with the MT Manager will contain the following MT Data 

messages: 

• Configuration data 

• Extended MT Specification data (eMTS) 

• Filter state message, message ID 0x98 (in case of data with preset “XDA 

processing”) 

• If enabled, UTC date and time at regular intervals (as configured) 

• If enabled, GNSS satellite SVInfo at regular intervals (as configured) 

• MTData2 at output frequency (as configured) 

 

The MT Manager software handles the request of these additional data packets from the 

MT (not only requesting MT Data) to enable full analysis of log-files in the MT Manager 

software later. 

 

NOTE: An MTB file can contain any number of MTData2 packets that are requested from 

the MT. Only if an MTB file contains Sensor Component Readout or sensors data (∆q/∆v 

or inertial data) and/or GNSS data messages, the data can be re-processed using 

different filter profiles. In all other cases the .MTB file is considered a log-file, which can 

be played back again for viewing. 

In the case that only sensors data and/or GNSS data is requested from the MTi, the MT 

Manager will run the sensor fusion filter in XsensDeviceApi64.DLL of the host PC (and not 

on the DSP of the MT) to estimate orientation, position, velocity. 

5.5 Output Files 

The MT Manager can export data logged in .MTB files to different formats as described in 

section 6.4.3. 

  

ASCII text data 

• Calibrated sensor data (3D acceleration, rate of turn, magnetic field, ∆q/∆v, free 

acceleration, etc.) 

• Orientation data 

• Position 

• Velocity 

The output orientation can be represented in different conventions: 

• Unit normalised Quaternions (also known as Euler parameters) 

• Euler angles: roll, pitch, yaw (XYZ Earth fixed type, also known as Cardan) 

• Rotation Matrix (Direction Cosine Matrix) 

 

Data and (UTC) time can also be included in the exported files. See 6.4.3.5 for more 

information on the columns of the exported ASCII file.  

 

 
3 The .MTB extension is associated with MT Manager. 
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KMZ geographic data 

• Timestamp 

• Position 

• Velocity 

• Orientation 

• GNSS Mode 

• UTC time 

 

KMZ files (available from MTi-G-710 and MTi-7data sets only) are excellent to study 

trajectories in e.g. Google Earth. 

5.6 Menu bar 

In the MT Manager menu bar you will find the following entries: 

 

 
Figure 15: The menu bar in MT Manager 

In the table below each (sub-) entry is explained. 

 
Table 3: The MT Manager menu structure 

Entry 
(level 1) 

Entry (level 2) Entry (level 3) Description 

File Open File  Open a previously recorded (shortcut: CTRL-O): 
• MT Manager log file (.mtb) 

• Xsens log file (.bin and .xm) 

• Xbus Master log file (.xm) 

• Binary log file (.bin) 

Close  Closes the currently opened file 

Export  Export an opened log file to (shortcut: CTRL-E): 
• ASCII formatted file 

For more details, refer to section 6.4.3. 

List of last opened 
files 

 A list of last opened files  

Exit  Closes MT Manager 

View Displays Device List Toggle to open/close Device list. Refer to section 
5.7.1  

Message Window Toggle to open/close the Messages window 

Device Settings Toggle to open/close the MT Settings dialog 

3D Orientation Toggle to open/close the 3D display of 

orientation 

Inertial Data Toggle to open/close the inertial data graph 

Orientation data Toggle to open/close the orientation graph 

Status Data Toggle to open/close the status graph 

Temperature Data Toggle to open/close the temperature graph 

Velocity Toggle to open/close the velocity graph 

Altitude Toggle to open/close the altitude graph 

Device Data View Toggle to open/close the Device Data terminal 

XDA Data View Toggle to open/close the XDA Data terminal 
(hidden by default, enable this feature through 
Tools>Preferences)  

Position Toggle to open/close the position graph 
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Space Vehicle 
Information 

Toggle to open/close the SV information graph 

UTC Date/Time Toggle to open/close the UTC date/time window 

Status bar  Toggle to switch on/off the status bar at the 
bottom of the MT Manager window. This status 
bar shows playback information, “extended” tool 
tips etc. 

Tools Preferences MT Manager Here you can change the following general 
settings: 
Graphs:  

- Euler Angles or Quaternions 
- Celsius or Fahrenheit 
- Toggle display graphs as strobes 
- File Plotting mode: Real time or All data 
- Display time in graphs 

Miscellaneous: 
- Orientation output frame 
- Toggle show docked MTw’s and log and 

visualize docked MTw’s 
- Enable RS485 Compatibility 
- Enable XDA Data View 

XDA options: 
- Allows to load an alternative filter 

profiles file (use by Xsens support 
department only) 

Logging Here you can change Logging Settings (refer to 
section 6.4.1) 

- Name of the log file (template) 

Restore 
Communication 

 Resets the communication settings of an MTi to 
the default factory settings, allowing to regain 
communication with an MTi in MT Manager (COM 
port interface only) 

Wireless 
configuration 

 Opens the wireless configuration window (MTw 
only) 

Power off All Docked MTws Powers off all docked and USB connected MTws 

Wireless system Powers off all MTws that have a wireless 
connection 

All Devices Powers off all MTws 

Window Tile  Tiles the open graph windows. Tiling will be done 
in order of opening. With 3 graphs, opening the 
graphs in a specific order determines which 
graph is over the entire height of the window in 
the left column and which graphs are placed as 
smaller windows in the right column.  

Cascade  Cascades the open graph windows  

Help Documentation  Links to the latest online documentation 

Support BASE – Knowledge 
Base and Community 
Forum 

Links to BASE – Articles, guides, FAQ and online 
user forum 

Contact Support Contact Xsens Product Specialists 

Updates Download Firmware 
Updater 

Links to the download page for the MTi Firmware 
Updater 

Check for new MT 
Software Suite versions 

Check for new MT Software Suite versions 

Online Shop  Opens the webpage http://shop.xsens.com 
where accessories and MT’s can be ordered.  

About MT Manager  Display version information and includes EULA 

http://shop.xsens.com/
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5.7 Data views, toolbars and buttons 

In this section the sub-windows, toolbars and button functionalities of the MT Manager 

are explained: 

 

 

5.7.1 The Device List  

By default, the Device List is displayed in a sub-window, showing useful information 

about your MT. Note that the Device List is read only.  

 
Figure 16: The Device List 

The information in Table 4 is available.  

 
Table 4: The data shown in the Device List 

Parameter Description Comments 

DeviceID  A unique DeviceID. See [MTi_10s_100s] for 
explanation of the DeviceID 

Fixed value, retrieved from 
device 

Product Code Product code, built up from type of device, 
product series, interface, accelerometer 
range and gyroscope range.  

Fixed value, retrieved from 
device 

Location ID Location ID that allows identifying the MTi in 
a system setup  

Can be set in MT Settings 
Dialog 

Serial Port USB or COM port number Automatically detected 

Filter Settings 

Profile 

The filter setting profile used for orientation  Can be set in MT Settings 

dialog 

 
Table 5: The MT System State shown in the Device List 

MT System State Description Comments 

Measuring The MT is outputting data  

Recording Data is being saved to file  

Flushing Data is being retransmitted after 
recording has been stopped 

Applies to Awinda MTw only 

Config Mode MT is in config mode. This happens when 
configuration messages are sent to the 

MT or when the user puts the MT in 
config mode 

When you close MT Manager, 
the MTi will go to Config Mode. 

See 
https://base.xsens.com/hc/en-
us/articles/115003997494  

File Mode (open) A file is selected. MT Manager is waiting 
for the user to process the file. 

 

File Mode (loading) A file is being loaded and processed   Progress is displayed in the 
fourth column. 

https://base.xsens.com/hc/en-us/articles/115003997494
https://base.xsens.com/hc/en-us/articles/115003997494
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File Mode (ready) Displayed when a file is loaded and when 
the entire file has been processed.  

 

File Mode (playing) Displayed when the file is being played 
back 

 

With the Device List, it is possible to disconnect specific devices. Right-click on any 

parameter associated with the MTi that needs to be disconnected, right click and choose 

Disconnect. The MTi will be removed from the Device List. 

 

 
Figure 17: Right-click on the Device allows to disconnect a single MT 

5.7.2 Device Settings 

In the Device Settings window several (low-level) settings can be changed, including the 

output configuration. Take caution in changing settings in Device Settings as these 

settings can have large effects on the MTi device. In this window it is possible to save 

and load a set of device-specific settings, including the output configuration that can be 

copied to other devices (with the same product code). You can always revert a device to 

its Factory Settings using the Revert button. 

 

For details on the Device Settings, please refer to Section 6.2.2. 

5.7.2.1 Output configuration 

In the Output Configuration tab, all output options of the MTi can be set, including 

frequencies and formats.  



   

 

 

 

 

  

 

26 www.xsens.com 

 
Figure 18: the Output Configuration tab for an MTi-G-710 GNSS/INS. Depending on the MTi 

attached, the Output Configuration window may show fewer options. 

5.7.3 Data Views 

The MT Manager offers a wide range of information displayed in its sub-windows, which 

can be opened and closed via the (Main Views and GNSS) toolbar buttons or the menu 

bar: 

 

  
 

 

 

The individual buttons and their functionality will be explained in the next sub-sections; 

availability of some of the buttons and related sub-windows depends on the type of the 

connected device (e.g. position and velocity information will not be accessible with e.g. 

MTi-20 VRU or MTi-300 AHRS). 

The icons corresponding with the button that activates a specific sub-window are 

displayed on the top left of each subsection. 

5.7.3.1  3D Box view 

The 3D Box View is a real-time graphical (OpenGL) representation of the MT orientation 

measurements, i.e. roll, pitch and yaw.  

Figure 19: The Data Views and GNSS toolbars 
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Figure 20: The 3D Box view is an easy way of visualizing the orientation of any MTi 

5.7.3.2  Inertial data view 

Per sensor type, the Inertial Data view graphically shows the 3D calibrated measurement 

data vs. time: 

• acceleration (from the accelerometers) in m/s2; 

• angular velocity (from the gyroscopes) in deg/s; 

• magnetic field (from the magnetometers) in normalised arbitrary units (a.u.). 
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Figure 21: The Inertial data view for acceleration, angular velocity and magnetic field 

Table 6 explains the line colours and the buttons in this view. 

 

 

 
Table 6: The line colours in the inertial data graph 

Colour Corresponding axis 

Red Acceleration, angular velocity (roll) and normalised magnetic field in X direction 

Green Acceleration, angular velocity (pitch) and normalised magnetic field in Y direction 

Blue Acceleration, angular velocity (yaw) and normalised magnetic field in Z direction 

Black Total acceleration, angular velocity or magnetic field, if available 

 

Automatic scaling 

It is possible to choose the scaling of the inertial data plot using the pull-down dialog. 

 

 
Figure 22: Tools let you configure the graphs 

Table 7: The different scaling options in the graph windows. 

Scaling option Functionality 

No auto scaling Y-scale will no longer be scaled 

Expand to fit Y-scale will be stretched to show all data in plot 

Full fit Y-scale will be stretched to show all data in plot 

Zooming 

When the Zoom-icon   is selected, you have several options to zoom.  
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Option 1: Press and hold either mouse button, drag mouse to make a zoom rectangle 

(right button zooms out, left button zooms in): 

 

 
Figure 23: A zoom rectangle in the Euler angles graph 

      -Release mouse button to zoom in/out to the zoom rectangle 

      -Press other mouse button to cancel the zoom 

      -Use scroll wheel to make minor adjustment to first point of the rectangle 

 

Option 2: Double click and hold one of the mouse buttons to generate a default zoom 

rectangle centered around the mouse position with zoom factor 2.0 (right button zooms 

out, left button zooms in): 

Then: 

      -Release mouse button to zoom in/out to the zoom rectangle 

      -Press other mouse button to cancel the zoom 

      -Move the mouse to move the zoom rectangle 

      -Use the scroll wheel to increase/decrease the zoom factor 

 

Option 3: Use scroll wheel without buttons pressed to simulate a double click centered 

around the mouse position and immediately applying the zoom i.e. apply a default zoom 

rectangle centered around the mouse position (right button zooms out, left button zooms 

in). 

 

- NOTE: Zooming is not possible when the autoscale method is set to “full fit”.   

 

Zooming in y-direction only 

When zooming with the above option, it can happen that new data will not be shown in 

the zoom box, as the x-scale (time) ends before the place where new data is created. In 

order to zoom only in y-direction, enable the function “show all samples” with the show 

all samples button:  
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When “show all samples” is enabled, the x dimension of the zoom rectangle is always the 

complete width of the graph: 

 

 
Figure 24: Zooming in y-direction only can be enabled with the button "show all samples" 

Panning the graph 

When the pan icon  is enabled, you can pan the graph with the following actions: 

- Press and hold left/right mouse button 

- Release the mouse to stop panning 

- Move the mouse to pan the graph  

NOTE: Panning is not allowed when the autoscale method is full fit 

 

 
Figure 25: Panning is available in all directions 

Showing data values 
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With the Show Values button  enabled, hovering over the graph will display the values 

at that moment.   

 
Figure 26: The Show Values button activates the possibility to see the values in the graph  

 

Showing less data channels 

With the checkboxes, it is possible to omit data from the plot. This way, you can closely 

investigate one particular signal. 

 
Figure 27: Turning off some of the channels allows for closer investigation of a particular signal 

Freezing a graph 

When you are using an MTi in live view, you cannot pause the file (see section 5.7.6), to 

investigate data further. In that case, you can use the freeze button and zoom and pan 

on visible data:  

 

Clearing and resetting graphs  

There are two ways of clearing and resetting graphs. To clear the graph, use the clear 

button . 

Another way to reset the zoom that is very convenient when you have used zoom and 

pan functions, is to close and open the graph.  

5.7.3.3  Orientation data view 

The Orientation data view shows the 3D orientation (calculated from the angular 

velocities) in either Euler angles in degrees vs. time or Quaternions vs. time 



   

 

 

 

 

  

 

32 www.xsens.com 

 

 
Figure 28: The orientation graph shows the orientation of the MTi over a period of 10 seconds 

 

Table 8 explains the line colours in “degrees vs. time” view: 
 

Table 8: Colours in the Euler angles graph 

Colour Corresponding axis 

Red Orientation of the X-axis 

Green Orientation of the Y-axis 

Blue Orientation of the Z-axis 
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Figure 29: The quaternion graph shows the 4 components in one graph 

 

Table 9 explains the line colours in the “Quaternions vs. time” view: 

 
Table 9: Colours in the quaternion graph 

Colour Description 

Red q1 

Green q2 

Blue q3 

Black q0 

 

Please refer section 5.7.3.2 for explanation of the various buttons and checkboxes.  

5.7.3.4  MT Status 

The MT Status sub-window displays various status flags. 

 

Be sure to enable the Status Data Output in MT Output Configuration dialog: 

 

 
Figure 30: Tick boxes for status in the Output Configuration window 
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Figure 31: The status window of an MTi-30 AHRS. In this particular screen shot, several gyroscopes 

are clipping 

 
Figure 32: The status windows of the MTi-G-710 and MTi-7 have two extra channels, GNSS Fix and 

Filter Mode 

Please refer section 5.7.3.2 for explanation of the various buttons and checkboxes.  
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Table 10: Signals in the Status window 

Colour Status data description 

Red Motion Tracker has passed the self-test according to eMTS. For an up-to-date 
self-test indicator, see [LLCP], RunSelfTest 

Light green Filter accuracy indicator; low=”not accurate”, high=”accurate” 

Dark purple Manual Gyro Bias Estimation (refer to https://base.xsens.com/hc/en-
us/articles/360002763354): 
1 (high):   running with no rotation assumption 

at 2/3 of the y-axis:  error: rotation detected, no gyro bias estimated 
0 (low):   estimation complete, no errors 

Bright blue GNSS fix; indicates if the GNSS receiver has a valid fix 

Orange RepMo: Representative Motion mode of In-run Compass Calibration (ICC) 
active 

Dark blue (3x) Clipping flags for the accelerometers, 20g 

Dark green (3x) Clipping flags for the gyroscopes, 450 deg/s or 1000 deg/s 

Dark red (3x) Clipping flags for the magnetometers 

Magenta Filter mode; indicates what the state of the filter in the MTi-G-710 or MTi-7 is, 
see [LLCP] 

5.7.3.5  Temperature view 

The Temperature view window shows the internal temperature of the device. 

Temperature data is visualized in degrees Celsius by default. In order to change to 

degrees Fahrenheit, go to Tools > Preferences > MT Manager > Graphs.  

 

 
Figure 33: The Temperature view window, showing that the MTi is warming up directly after 

powering it.  
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5.7.3.6  Velocity view 

The Velocity view window visualizes the 3D velocity of the MTi (MTi-G-710 and MTi-7 

only). By default, Velocity is visualized in the East-North-Up (ENU) format. In order to 

switch between ENU, NWU and NED visualizations, go to Tools > Preferences > MT 

Manager > Graphs.  

 

 
Figure 34: The Velocity data view, displaying 3D velocity in m/s 

 

5.7.3.7  Altitude view 

The Altitude view window visualizes the altitude of the MTi (MTi-G-710 and MTi-7 only). 

Altitude is displayed as height above the WGS-84 Ellipsoid in meters.  
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Figure 35: The Altitude data view, displaying height above the WGS-84 Ellipsoid in meters 

 

5.7.3.8  Position view 

The Position view window visualizes the 2D position of the MTi (MTi-G-710 and MTi-7 

only). Position is displayed in terms of longitudinal and latitudinal coordinates.  

 

 

 
Figure 36: The Position view, displaying 2D position 
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5.7.3.9  Space Vehicle Information window 

The Space Vehicle Information (or SatInfo) Window shows the various satellites with 

their respective signal strength in dBHz.  

 

The columns are labelled according to the constellation and the number of the space 

vehicle. The digit in front of the semicolon indicates the satellite system, the number 

after the semicolon is the satellite number. E.g. 0:5 indicates Space Vehicle #5 from the 

GPS constellation. The labels are 

 
Table 11: Colours used in the SV information window 

Label Color Meaning 

Detected (unused) Blue The satellite data is not used for the navigation 
solution. 
Note that SBAS satellites (1:#) can only be detected 
or unhealthy. If SBAS corrections are being used for 
the GPS satellites, the GPS satellites are light green.  

Used Dark green The satellite data is used for the navigation solution. 

No differential corrections have been applied. 

Used+D Light green The satellite data is used for the navigation solution; 
differential correction have been applied. GLONASS 
satellites do not have differential corrections, so they 

are always dark green if used for the navigation 

solution 

Unhealthy Red The satellite data is not used  

 

 
Figure 37 The SV info window showing 5 GPS satellites and 6 GLONASS satellites being used for 

the navigation solution and 2 satellites that have been detected.  
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5.7.3.10  UTC Time view 

The UTC Time view window visualizes the UTC Time output of the MTi. The GNSS receiver 

automatically retrieves UTC Time for the MTi-G-710 and MTi-7. For all other devices, UTC 

Time can be set manually (see 6.2.2.4). 

 
Figure 38: The UTC Time view.  

 

 

5.7.3.11  Device/XDA Data View terminals 

The message terminal shows messages sent to and received from the device or the 

Xsens Device API (XDA) in real-time. The Device Data View terminal can also be used to 

compose low-level messages in order to quickly understand the communication protocol. 

See section 6.3 for more information about the message terminals. The XDA Data View is 

hidden by default. It can be enabled through Tools>Preferences.  

 
Figure 39: The message terminals for the device (left) and XDA (right) 

 

5.7.3.12 Message window 

The message window shows warnings and other informational messages.  
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Figure 40: The messages window may show warnings on e.g. missed data packets 

 

5.7.4 Connectivity 

With the Connectivity toolbar you can control connecting your devices: 

 

 
Figure 41: The Connectivity toolbar 

 

Please refer to section 4.2 for details on how to connect and disconnect your devices. 

 

5.7.5 File control  

The file control tool bar makes it possible to choose where files are stored and opened. 

 

 
Figure 42: The File control toolbar 

 

Table 12: Meaning of buttons in the File Control toolbar 

Icon Action 

 
Open a previously recorded file (see also “File → Open…”) 

 
Export an opened log file (see also “File → Export…”) 

 
Set the Current Directory (by browsing) 

5.7.6 Playback & recording 

To be able to record data and playback recorded data, the MT Manager offers the 

Playback & Recording toolbar.  

      
Figure 43: The Playback and recording bar when an MTi is attached (left) and when a file is loaded 

in MT Manager (right) 
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Table 13: Meaning of the buttons in the Playback and Recording toolbar 

Button name Button 
icon 

Functionality 

Record/ 

Stop Record  

Pressing this button will turn on the logging of data to a file (see 

also section 6.4.1) 
Releasing this button in recording mode, will turn off the logging 

Play 

 

Pressing this button will start (or continue) playback of logged data 

(see also section 6.4.2) 

Rewind 

 

During playback, pressing this button will go to the start of the 
logging 
 

 

 

5.7.7 Orientation resets 

 

Please refer to [MTi_10s_100s] for detailed information about orientation resets and the 

effects these have. Available resets are summarized in Table 14. Note: be cautious to use 

the orientation resets. 

 
Table 14: The available orientation resets 

Reset type  Functionality 

Heading reset redefines North to the x-axis of the device – applies to 
RotLocal 

Inclination 

reset 

redefines device coordinates system such that 

momentary inclination is zero – Applies to RotSensor 

Alignment 
reset 

combines the heading reset and the object reset – applies 
to both RotLocal and RotSensor 

 

After choosing the reset type, press the Reset Orientation button .  

 

You can also choose to apply the reset on the current device or on all connected devices. 

After a reset you can store the new values to the MT Settings by pressing the Store 

Orientation button . 

 

 
Figure 44: The orientation resets toolbar can be used to apply a specific reference coordinate 

system to the MTi's orientation, velocity and sensors data output 
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5.7.8 In-run Compass Calibration & Representative Motion 

In-run Compass Calibration is a way to calibrate for magnetic distortions present in the 

sensor operation environment using an onboard algorithm leaving out the need for a host 

processor like a PC. It estimates the hard- and soft-iron effects and provides new 

magnetometer calibration parameters. To expedite the calibration of the magnetometer 

sensor readings with respect to the new field, there is a feature called Representative 

Motion. Click the button Start/Stop Representative Motion and rotate the device together 

with the object that disturbs the magnetic field in all directions of the actual application.  

 

 
Figure 45: Click the Representative Motion button to start the Representative Motion mode. Click it 

again to stop the Representative Motion mode.  

 

If you want to store the new values in the non-volatile memory (remember that they are 

discarded when you power cycle the MTi), press the store button:  

 

 
Figure 46: This button stores the ICC parameters in the non-volatile memory 

 

For more information on ICC and Representative Motion, refer to the following link on 

BASE: https://base.xsens.com/hc/en-us/articles/213588029  

 

 

 

5.7.9 Manual Gyro Bias Estimation 

Manual Gyro Bias Estimation is a way to quickly estimate the gyroscope zero-rate offsets 

or biases. This feature can be particularly useful when trying to reduce Heading drift with 

VRU devices or slowly moving GNSS/INS devices. Manual gyro bias estimation forces the 

filters of the MTi to estimate the gyroscope biases by assuming that the MTi will be held 

motionless for a given period of time.  

 

In order to perform a manual gyro bias estimation using MT Manager, click the 

corresponding icon, . A window will open, providing guidelines to the user. For more 

information on this feature, refer to BASE: https://base.xsens.com/hc/en-

us/articles/360002763354. 

https://base.xsens.com/hc/en-us/articles/213588029
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Figure 47: The Manual Gyro Bias Estimation window guides the user through the use of the feature.  

 

 

 

 



   

 

 

 

 

  

 

44 www.xsens.com 

6 Operating guidelines 

6.1 Overview 

This section describes the configuration and typical utilisations for managing your devices 

with the MT Manager. 

6.2 Configuring the MT Manager and your devices 

6.2.1 General settings 

Changing the settings of your devices can be done (dependent on the setting) in: 

1. Device Settings sub-window (refer to section 5.7.2). 

2. Message terminals (refer to section 6.3). Be cautious when changing settings here, 

as you can send any message to the MTi, even if the specific MTi does not support 

the message. 

 

Note: changing the settings in the Device Settings window requires the user to explicitly 

invoke writing to the MT: 

 

Press the “Write to MT” button, to actually save your changes to non-volatile memory 

in the MT device. MT Manager will then write the settings to the device and rescan for 

devices: 

 

 
Figure 48: In the Device Settings window, it is important to write the changes made to the MTi 

6.2.2 Using the Device Settings window 

The Device Settings window lets you modify all non-data output related settings, 

such as communication and filter settings.  

 

6.2.2.1 Header 

 
Figure 49: The header shows general information on the MTi 
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In the header, you will find the following parameters (all read-only, except for 

LocationID). 

 
Table 15: Explanation of the information in the header of the Device Settings window 

Parameter Description 

DeviceID 8-digit unique DeviceID of MTi (hexadecimal), refer to [MTi_10s_100s] 

for details on the format 

Product Code The product code of the connected MTi or file, refer to [MTi_10s_100s] 
for details on the format 

LocationID Can be used to identify Motion Tracker by a number (0-255) instead of 
its Device ID. This can be particularly useful when a fixed setup with 

multiple interchangeable MT’s is used 

HardwareID HardwareID indicates the hardware DeviceID. This ID is assigned during 
assembly 

Hardware Revision Hardware revision of the MTi  

MT Settings revision The extended Motion Tracker Settings layout 

Firmware Revision Firmware revision of the currently connected MTi.  

Self test When all sensors passed the Built-in Selftest (BIT), this shows 00001FF. 

This field is only visible for MTis supporting the self test functionality 

Test & Calibration 
Date 

Shows when the device was tested and calibrated at Xsens 

6.2.2.2 MTi configuration file  

With the MT Manager it is possible to save and load predefined set of settings, such as 

synchronization settings, output configuration and baud rate. These settings can be 

copied from a device into a dedicated file. The file can then be loaded and the same 

settings can be applied to another MTi with the same product code, e.g. MTi-30. This 

feature is useful for system integrators that need to configure many MTi’s. Note that this 

feature is only available with devices with a firmware version of 1.2.3 or higher.  

 

The following settings are saved (message ID between square brackets): 

 

1. RotSensor and RotLocal [0xEC] 

2. Baudrate [0x18] 

3. Filter profile (if available, otherwise the filter profile in the device will be used) 

[0x64] 

4. Extended Output Mode [0x86] 

5. Position (Latitude, Longitude, Altitude) [0x6E] 

6. Location ID [0x84] 

7. OptionFlags (see [LLCP] for full contents) [0x48] 

8. OutputConfiguration [0xC0] 

9. OutputMode (legacy) [0xD0] 

10. OutputSkipFactor (legacy) [0xD4] 

11. Period (legacy) [0x04] 

12. SyncSettings [0x2C] 

13. GnssPlatform [0x76] 

 

To save a setting, click the “Save Settings” button in the MT Settings dialog. 
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A pop-up screen opens that allows you to save the settings in a name that you prefer. As 

the settings are product dependent, you could include the name of the product in your 

file name, e.g.”Test1_MTi-30.xsa”.  

 

To load a settings file, click the “Load settings” button. Again, a window opens that lets 

you navigate to an xsa configuration file. Opening the file applies all the settings to the 

MTi in the order listed above. When no or only some settings cannot be applied, a 

warning will be issued. Settings that could be applied up until the incompatible setting 

will be applied though.  

 

Although the configuration file can be read, it is not recommended to make changes in 

the file. It is easier to load the settings in the device, make the required changes and 

save the settings again (in the same file).   

6.2.2.3 Modeling parameters 

In the modeling parameters tab you can find the calibration parameters of the 

accelerometers, gyroscopes and magnetometers (offset, gain and misalignment, refer to 

[MTi_10s_100s] for details).  

 

 
Figure 50: The modeling parameters show values determined in Xsens' calibration procedure 

 

6.2.2.4 Device Settings 

In the Device Settings tab, you will find options to set up the MTi’s communication and it 

is possible to change the behaviour of the sensor fusion algorithm in the MTi.   
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Table 16: The information displayed in the Deveice Settings tab 

Parameter Description 

COM port baud rate Although the easiest setup with MT Manager is to communicate 
with the USB cable that has no baud rate, it is possible to set the 

baud rate here. This can be used when you configure the MTi in MT 
Manager and later want to use the serial interface on another 
platform. In order to reduce waiting times in the usage of MT 
Manager, the MT Manager is designed for high baud rates. Don’t 
use baud rates of 9600 or 4800 when connecting the MTi to MT 

Manager.  

USB name This string identifies the USB string. Use this string in your 
application when you want to communicate directly to the USB-
port.  

Filter Settings  Choose the filter profile that you want to have the orientation 
estimated with. When you choose an orientation output in the 

Output Configuration window, choose “Onboard: ….” If you are 
outputting only ∆q/∆v, inertial data or SCR, choose the required 
setting profile in “XDA: …..” Refer to [MTi_10s_100s] for more 

information on the various filter profiles. Only filter profiles that are 
applicable for the attached MTi are shown 

Option Flags You can indicate here whether the sensor fusion algorithm should 
use additional sensor fusion algorithms. These features are 
disabled by default. Refer to [MTi_10s_100s] for more information 

on these features.  

GNSS Configuration This field allows to choose which constellations must be used. This 
can be GPS & BeiDou, or GPS & GLONASS (default). MTi-G-710 and 
MTi-7 only.   

GNSS Platform This field allows to use a different GNSS setting. Advised to use 

only after consultation with Xsens. MTi-7 and MTi-G-710 with FW 
version 1.7.x or higher only. 

Position This position is the last known position of the MTi, either inputted 
via a message (see [LLCP]) or via the GNSS receiver. This data is 
used to estimate local magnetic declination and local gravity. 

UTC Time With Set current, the current time (in UTC format) is retrieved from 
the computer and written into the RAM of the MTi. When recording, 
the data will now include the time. Note that the time is discarded 
after a rescan, power off or revert.  

RotSensor and RotLocal These two rotation matrices are used to apply orientation resets or 

arbitrary alignments. Refer to [MTi_10s_100s] for more information 
on these two matrices. RotSensor rotates S to S’, RotLocal rotates 
L to L’  
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Figure 51: Device settings in the MT Settings dialog show various device-specific settings 

6.2.2.5 Output Configuration 

The output of the MTi can be fully configured in terms of data packets in the data 

message, output frequency, and representation format. This can all be done in the 

Output Configuration tab. There are two different modes in the output configuration 

dialog as shown in Figure 52.  
Table 17: The modes in the Output Configuration window 

Mode Description 

Normal mode Mode that supports MTData2 data packets.  

String mode Mode that supports ASCII Strings (NMEA).  

 

 
Figure 52: The mode can be selected with the radio buttons 

Normal mode Output Configuration Window 

For the MTi 1-series, the MTi 10-series and the MTi 100-series, the most complete Output 

Configuration Window is shown in Figure 53. When the MTi is first used, or when it is in 

factory settings, the Output Configuration window will be in Normal Mode with the 

outputs in the default configuration (the default configuration depends on the product, 

see [LLCP]). The Output Configuration Window only shows the outputs available for the 

connected MTi.  
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Figure 53: The Output Configuration window of an MTi-G-710 that is attached to MT Manager. 

When another device is attached, the output configuration window may contain fewer options. 

 

String report mode Configuration Window  

 

The String report mode Configuration Window allows setting the ASCII strings for MTi 10-

series and MTi 100-series. Note that only a single frequency can be chosen here. Setup 

the string reports with the message terminals or via XDA to apply different update 

frequencies per string output.  

 

 
Figure 54: String report mode output configuration options 

See [LLCP] for details on the various NMEA messages.  
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Output configuration window in file mode 

The output configuration window will be read-only when a file is loaded. It is possible 

however to view the settings of the recorded file.  

 

 
 

Figure 55: The Output Configuration Window of a file that contains data from an MTi-G-710. All 
outputs are shown, but cannot be edited. 

The meaning of all data fields and screens is explained in [MTi_10s_100s] and [LLCP]. A 

few functionalities of the Output Configuration window are explained in Table 18. 

 

 
Table 18: Buttons in the Output Configuration window 

Button/option/functionality Description 

 
The radio buttons allow switching between Normal 
mode and String Report Mode.  

 

The presets are a safe choice if you do not know 

which data you need for later re-processing with 
other filter profiles, how to retrieve processed data 
etc. It is highly recommended to use these presets. 
There are three presets: 

- XDA processing 
- High-Rate Calibrated Outputs 
- Onboard processing 

XDA processing offers the most flexibility and is the 
recommended setting when you want to reprocess 
data later with different settings in XDA. The data of 
all sensors has already been processed in the SDI 

algorithm, so that the amount of data stored is 
relatively low, yet the accuracy is guaranteed.  
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High-Rate Calibrated Outputs includes 
AccelerationHR and RateOfTurnHR, which are 
calibrated outputs at frequencies up to 1000 Hz.  
Maximum output rate, degree of signal processing, 
and calibration applied depends on device and 
hardware version. For more information, see [LLCP].  
Onboard processing is the desired setting, when you 

know what settings you need. All data is calculated 
onboard the MTi and does not need further 

processing.  
 
Starting from a preset, you can tick/untick outputs. 
In this case, the preset drop-down menu will 
become empty.  

 
Ticking this box will make all formats (Floating 
point, Fixed point etc.) the same for each output as 
long as these are available. See [MTi_10s_100s] 
and [LLCP] for more information on the output 
formats.  

 
Ticking this box will make all output frequencies the 
same for each output if they are available. If a 
certain frequency is not available, the output 
frequency of that output will be rounded off to the 
next lower available output frequency 

Frequency of Timestamp and Status Timestamp and Status do not have an output 
frequency: they are outputted with every data 
message.  

 

Getting ready for logging 

Before you start logging your data, be sure to make the following steps first: 

1. Set the Log File Name and set the desired working directory, refer to section 6.4.1 

2. Choose the desired output format, refer to section 6.2.2.5. For post-processing 

purposes, make sure to use the XDA processing preset. MT Manager will select the 

required data packages for post-processing, so it is possible to add more outputs.  

3. Setup the desired coordinate system (see section6.2.2.4) on using the Sensor 

Rotation Matrix and the Local Rotation Matrix. With the MT Manager, the coordinate 

system used in the sensors data cannot be changed during post-processing.  

4. Choose the correct baud rate when using serial interfacing. Make sure this baud 

rate is high enough to accommodate data sent over the serial interface (total data 

size and frequency, see [LLCP]).  

5. Choose the setting profile most appropriate for your application. It is possible to 

process sensors data with another filter profile, but note that orientation data 

cannot be reprocessed at all.  

 

Note: The first packet counter is an arbitrary number between 0 and 65535 due to 

the recording concept used in MT Manager. 
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6.2.2.6 Synchronization options 

For detailed explanations of the functions and how to use them, refer to the [LLCP] and 

https://base.xsens.com/hc/en-us/articles/211592185-Synchronization-with-the-MTi.  

 

When opening the Synchronization configuration tab in the Device Settings window, the 

Configured Settings list is empty for most MTi devices. Press add to start configuration of 

a synchronization function.  

 

 

 
Figure 56: Starting the setup of a synchronization option. 

  

https://base.xsens.com/hc/en-us/articles/211592185-Synchronization-with-the-MTi
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Table 19: List of available synchronization functions 

Function Sync Line1 Functionality 

Trigger Indication In 1 When a pulse is received, a marker is set in the 
MTData2 packet 

Send Latest In 1 
ReqData message 

When a pulse or specific (ReqData) message is received, 

the latest available data in the MTi is sent to the user. 

Interval Transition 
Measurement 

SyncOut A pulse is generated at 400 Hz and can be used to 
trigger external devices.  

Clock Bias Estimation ClockSync Using this function allows you to synchronize the MTi 

with an external pulse (0.1 to 1000 Hz). 

GPS Clock Sync GPS Clock In This (default on) synchronization pulse synchronizes the 
clock of the MTi-7 and MTi-G-710 with the GPS clock. 

StartSampling In 1 When a pulse is received, samples will be sent to the 

digital signal processing pipeline.  

1 PPS SyncOut 1 Pulse Per Second, sent directly from the GNSS 
receiver from the MTi-7 and MTi-G-710. 

1 Refer to [MTi_1s] and [MTi_10s_100s] to find the hardware lines that correspond to the terms used in the MT 

Software Suite.   
 

The graphic in the screen will help you determine the behaviour of each function and 

parameters. The red line in the graphic shows the voltage received or sent out; the grey 

arrows or grey lines show the MTData2 packets. If functions are on separate Sync lines, 

they can be used together.  

 

Trigger Indication: 

The function trigger indication can be used to get a marker inside the MTData2 packet 

without interfering with the data itself.  
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Figure 57: Trigger Indication sets a marker in the MTData2 packet when a voltage is read on the 

SyncIn line. The red line represents the voltage on the Sync line 

Table 20: Synchronization options of the Trigger Indication function 

Parameter Options 

Line In 1 

Skip factor Applying a Skip factor allows you to omit markers from the MTData2 packet. E.g. 
when a Skip Factor of 1 is used, Trigger Indication will omit every second 

marker. 

Polarity Rising Edge, Falling Edge or both: allows you to change the edge on which the 
TriggerIndication must be included 

Delay (µs) The number of microseconds before the marker must be included in the data 

 

 

Send Latest: 

Send Latest allows to send the latest available data that has been processed onboard the 

MTi (it is thus used as a SyncIn). Send Latest ignores the output frequency selected in 

the Output Configuration window (but not which outputs are selected) and will prevent 

data from being outputted until a Send Latest pulse or ReqData message is received. As 

sampling is done at a very high frequency, it is not possible to let the sample moment be 

determined by the Send Latest function. However it is possible to adjust the frequency of 

the sampling, use the ClockBiasEstimation function for that. Remember that it is possible 

to use functions together if they are on separate Sync lines.  

  

The following parameters can be used: 

 
Table 21: List of options for Send Latest synchronization functionality 

Parameter Options 

Line In 1 or via a message (ReqData) 
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Skip factor Applying a Skip factor allows you to discard SyncIn pulses. This makes it 
possible to have e.g. a 1 Hz input pulse or ReqData message, but output MT 
Data only every 5 seconds.  

Polarity Rising Edge, Falling Edge or both: allows you to change the edge on which the 
Send Latest command must act. Not applicable to ReqData.  

Delay (µs) The number of microseconds before data must be sent. If new data is available 
after the reception of Send Latest and the delay together, that new data will be 
sent.  

 

 
Figure 58: Send Latest configured as Rising Edge 

Interval Transition Measurement: Interval Transition Measurement sends out a pulse 

on the SyncOut line at a frequency of 400 Hz (when Skip factor is 0). Interval Transition 

Measurement can be used to trigger external devices.  
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Figure 59: The Interval Transition Measurement with its default settings.  

 

 

 
Table 22: List of options for Interval Transition Measurement (SyncOut) functionality 

Parameter Options 

Line SyncOut 

Skip factor Applying a Skip factor will reduce the number of sync pulses on the SyncOut line. In 

the MTData2 packet, a marker is included that allows you to see which data packet 
corresponds to the Interval Transition Measurement pulse. Note that it is 
recommended to have a resulting SyncOut frequency that is a integer division of the 
data output frequency. E.g. when a SyncOut frequency of 100 Hz is chosen and the 
data output is 80 Hz, you will miss markers in the data.  

Polarity The polarity field allows you to choose whether the pulse should be low and will rise 

upon a SyncOut pulse (Rising Edge), should be high and will fall upon a SyncOut 
pulse (Falling Edge) or should toggle between high and low upon a SyncOut pulse 
(Rising & Falling Edge). In the latter case, pulse width does not have an effect.  

Offset (µs) The offset allows you to send out a pulse before or after the MTData2 package it 
corresponds to, is sent to the host. As timing in the MTi is exactly known, it is 

possible to send out a pulse up to 3 seconds before the data package.  

Pulse 
Width (µs) 

Pulse Width allows you to determine the duration of the pulse on the SyncOut. If the 
pulse width is longer than 2500 µs and no Skip Factor is applied, the pulses will 
overlap.  

 

 

Clock Bias estimation: It is possible to slightly adjust the duration of the clock ticks of 

the internal sampling in the MTi. This can be useful when you have an accurate external 

clock (e.g. GPS time pulse, 1 PPS) that you want to synchronize the MTi to. It can also be 

useful to synchronize multiple MTi’s, so that the number of data points in a certain 
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amount of time is equal. For Clock Bias Estimation, it is needed to know the frequency of 

the signal you feed into the MTi. Note that you can still choose another output frequency, 

unrelated to Clock Bias Estimation. 

 

 

 

 
Table 23: List of options for Clock Bias Estimation synchronization functionality 

Parameter Options 

Line Clock In 

Skip factor Applying a Skip factor allows you to discard SyncIn pulses. Make sure however that 
the Clock Period matches the voltage frequency, including Skip Factor. Example: when 
applying a 100 Hz voltage signal with a skip factor of 1, the period should be 20 ms.  

Polarity Rising Edge, Falling Edge or both: allows you to change the edge on which the Clock 
Bias Estimation must calculate. 

Delay (ms) The number of milliseconds between pulses. Read Skip Factor (above) if you want to 
use Skip Factor as well.     

 

 

 
Figure 60: Clock bias estimation on a clock of 4 Hz.  

GPS ClockSync: 

When the MTi-7 or MTi-G-710 has a valid GNSS fix, the time pulse from the GNSS 

receiver is used to synchronize the internal clock of the MTi. The functionality is identical 

to the (external) Clock Bias estimation.  
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Figure 61: GPS Clock Sync synchronizes the crystal of the MTi and the GPS clock. 

The GPS ClockSync function is enabled by default with specific settings; it is possible to 

disable the functionality or adapt the settings though. This is not recommended and 

should only be done when a more accurate clock is available or when a different clock 

bias estimation is required. A warning dialog will pop-up; choosing Yes will re-enable the 

GPS Sync. 

 

 
Figure 62: Warning that you are about to delete the GPS clock Sync 

StartSampling 

StartSampling can be used to accurately time the reception of the MTi data. It is not 

possible trigger every sample, but it is possible to start the digital signal processing. 

Refer to [MTi_10s_100s] for more info.   
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Figure 63: With StartSampling, the MTi will only start sending data when a pulse has been received 

1PPS Time-pulse (Out): The MTi-7 and MTi-G-710 can output a hardware pulse (length 

100 us) every second at the exact UTC second.  

 
Figure 64: 1 PPS Time pulse in the Synchronization dialog 

 

Multiple functions: 

It is possible to configure multiple synchronization functions on the MTi. This can be 

useful if you need to synchronize multiple devices, see [MTi_10s_100s]. If multiple 

entries are set on the same line, an error is given (see below).  
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Figure 65: The Sync Options dialog gives a warning when settings are conflicting or duplicate 

 

Deleting a configured setting: 

In order to remove a setting, select the configured setting in the Configured Settings list 

and click Delete.  

6.3 Using the Device/XDA Data View terminals 

MT Manager has two message terminals: the Device Data View shows the communication 

over the serial or USB port; the XDA Data View shows the communication between MT 

Manager and the Xsens Device API. To understand the low level XBus Communication 

protocol, it is recommended to use the Device Data View.  

6.3.1 Device Data View 

The Device Data View allows monitoring the communication over the serial or USB 

interface of the MT (i.e. the XBus Communication protocol, see [LLCP]). It can also be 

used to compose messages in ASCII; the composer will set the required bits, will include 

the XBus header (preamble, message ID etc) and will calculate the correct checksum. 

The message can then be written to the device.  
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Figure 66: The Device Data View showing data that is being received from the MTi device. 

 

 
Table 24: Functions available in the Device Data Viewer 

Button/field Description 

GoTo Config This button can be used to put the MT in Config mode. Config mode is required 
to set most messages.  

GoTo 
Measurement  

This button can be used to put the MT in Measurement mode. Measurement 
mode is the mode in which the MT sends data messages.  

Send The send button is used to send composed messages to the device.  

Compose 
message 

The part “compose message” contains several fields: 
- “Compose”: Use this field to find the message you want to send to the 

device. You may also start typing in this field; the field has an autofill 
function.  

- “Preamble”: This is always FA 
- “BID”: Bus Identifier, FF means that the message will be sent to all 

devices on the bus.  

- “MID”: Message Identifier, this field will be filled out automatically when 

the “Compose:” field is filled out. You can also insert a MID here, the 
correct “Compose”: message will then be chosen.  
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- “Len data”: this field indicates the length of the data field. Extended 
length appears automatically when data field is longer than 254 bytes.  

- “Data”: The data field is used to set arguments for messages. Refer to 
[LLCP] for more interpretation. 

- “Edit”: Use the edit button to easily set the “Data” field. 
- “Checksum”: the checksum is calculated when composing a message 
- “Message”: the entire message is shown in this field. It is possible to edit 

the message here as well.  

Sent to 

Device 
and  
Received 
from device 

This window shows all messages sent to/received from the device. The sent 

window includes messages that were generated by e.g. the user interface of MT 
Manager, so it is ideal to investigate which communication is used when using 
the MT Manager.  

- The number of total messages sent is shown 

- The number of messages in the buffer is shown. Right-clicking on the 
window allows you to change the buffer.  

- The rate of messages per second is shown.  
- A pause button is available to stop the message stream, so you can 

investigate and scroll 
- When Parse MID is checked, the Message ID is shown in human readable 

format.  
- When Parse Data is checked, the data is shown in human readable 

format.  

6.3.1.1 Using the message dialogs 

The Device Data view has two fields that display the messages sent to the device and 

received from the device. Both fields have the same features. This section covers the 

analysis of Xbus data or “Normal output” messages. Alternatively, if the MT is configured 

to output NMEA strings, then these outputs can be visualized by selecting the “String 

output” radio button. 

 

 
Figure 67: A typical view of received MTData2 messages shown in the Device Data View 

 

The first column contains a counter, not related to the Data ID “Packet Counter”. The 

second column contains the timestamp of the message (hh:mm:ss.sss). The message 

itself is split into 5 different parts 

- FA FF: Preamble and Bus ID 

- MID: default shown in human-readable format, e.g. MTData2 

- Length of the data message (in italic) 

- Data in the message, default in hexadecimal format 

- Checksum (in bold) 
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Double-clicking on the data message opens a dialog that shows which data is in the 

message. It shows the message ID, number of data items (if applicable) and a 

description of the individual items, both parsed and in hexadecimal format.   

 
Figure 70: Double-clicking on the data will show the contents of a message, both parsed 

and in hexadecimal format 

 
Figure 68: Right-clicking on the data in the window shows a menu with options 

 
Table 25: The options in the menu in the Device Data Viewer after right-clicking the data. 

Menu option Description 

View Data Field View Data Field opens the dialog that shows the components of the 

data message 

Copy to Clipboard Copies selected messages to .txt or .csv. Use CTRL+A to select all 
messages in the window 

Pause Pauses the message stream 

Resume Resumes the message stream 
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Clear Clears the buffer and screen 

Human readable MID field When checked, the hexadecimal message ID’s are parsed to human 
readable text. This field is checked when opening the message 
terminal 

Human readable data field When checked, the hexadecimal data values are parsed to human 

readable text 

Show Date When checked, the date (dd/mm/yy) is shown next to the 
timestamp 

Max number of messages This setting allows to change the buffer size  

 

6.3.1.2 Composing a message 

Using the message terminals to set the MTi is straightforward. Note that you often need 

to be in Config Mode to be able to write a message. Then, choose the Message you want 

to send, using the dropdown menu.  

 

 
Figure 69: Composing a message in the Device Data View can be done by selecting a message 

from the "Compose' menu 

 

When you choose a message that starts with “Set” or that needs extra arguments, the 

text in the button marked “Edit” will be augmented with an Enter icon ().  

 

 
Figure 70: Click "edit" to make changes to the message selected from the "Compose" menu  
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Press Enter or Edit to edit the Data field; you could make changes in the field itself as 

well.    

 

 
Figure 71: After clicking “edit”, the data field from the message can be edited. 

When the data message is composed, the Send button is augmented with an Enter icon 

(). Press Enter or the Send button to send the message to the MT. Note that you should 

receive an Acknowledge message; visible in the “Received from”-field.  
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Figure 72: Messages showing the acknowledge sequence in the low-level Xbus protocol 

To verify the settings you just wrote to the device, you can request the settings; in this 

case the settings were correctly set:  
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Figure 73: An example showing how to request settings from the MTi device. 

6.3.2 XDA Data View 

The XDA Data View is hidden by default. It can be enabled through Tools > Preferences. 

The XDA Data View allows monitoring the communication from XDA to MT Manager. 

Comparing this with the messages in the device message terminal shows which 

messages are added or calculated by XDA. The XDA message terminal can also be used 

to compose messages in ASCII; the composer will set the required bits, will include the 

XBus header (preamble, message ID etc) and will calculate the correct checksum. The 

message can then be written to the device.  

 

The dialog for the XDA message terminal is very similar to the dialog of the device 

message terminal. Two fields are added: the “Data packets”-field and the “Other 

messages”-field. The fields “Sent to device” and “Received from device” are the same as 

the fields in the device message terminal (see 6.3.1), with the exception that MTData2 

messages are excluded from these fields (i.e. only Set-, Req-messages and their 

acknowledge messages are shown).  
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Figure 74: The XDA message terminal has an extra field with respect to the Device Data Viewer, 

showing the data received from the Xsens Device API (XDA) 

 

The “Data packets”-field shows the data packets that are generated by the Xsens Device 

API. These do not have to be the same as the data messages that are sent by the MT: 

when XDA processes e.g. orientation data based on dq/dv, orientation data is added to 

the data packets stream (depending on the selected output configuration).  

 

The “Other messages”- field shows warnings generated by XDA.  

 

Documentation on all functionality can be found in 6.3.1.  

6.4 Typical utilisations 

This section describes a selection of typical utilisations of the MT Manager. 
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Note: It is necessary to let the system stabilise right after start-up (filter stabilisation can 

take up to 60 seconds) in order to get more reliable measurements. 

6.4.1 Logging data 

Logging data can be started and stopped by pressing the “Record / Stop Record” button 

(see also section 5.7.6): 

 

 

The generated log file (.MTB file) will be written to the folder specified in the toolbar in 

the top of the main window under “Current directory”. By default, this is the root 

directory of the MT Manager installation (e.g. C:\Program Files\Xsens\MT Software Suite 

xxxx.x\MT Manager). 

This setting can be changed in the toolbar in the top of the main window under “Current 

directory”. Make sure that you have administrator permission for the folder you want to 

save data in.  

 

The default log file name can be changed by going to “Tools” ➔ “Preferences…” and 

selecting “Logging”: 

 
Figure 75: The logging name can be changed in the Preferences window. Use <time> and/or 

<trial> to ensure unique file names 

6.4.2 Replaying logged data 

Playback of logged data can be done by opening an .MTB file that has been previously 

recorded: 

Go to “File” ➔ “Open File…” (or by pressing “CTRL+O”) and select the .MTB file: 
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Figure 76: Log files of the MT Manager have an .mtb extension 

A dialog will be opened that allows you to set the filter profile to process the data with 

(also exporting). If you want to process the data with a different filter profile, you have 

to reopen the file. 

 
Figure 77: When opening an .mtb that contains SDI data, you choose the desired filter profile 

When you have selected the applicable filter profile, a dialog opens that shows the file 

loading progress.  

 

 
Figure 78: The file loading screen, displaying relevant information on file 



   

 

 

 

 

  

 

71 www.xsens.com 

Table 26: Parameters shown when data is being processed from a file 

Button/field Description 

Device Shows the DeviceID of the Motion Tracker of which data is being loaded 

Filename Full path and file name of the file being loaded 

Orientation - Not available in file: XDA processes orientation (and position) data 
with the filter profile selected. 

- Available in file: orientation and position data is not reprocessed, not 
even when dq/dv is available in the file. The filter profile is ignored 

XDA profile When XDA (MT Manager) is processing orientation data, this file shows the 
XDA profile being used. When orientation data is in the file, this field shows 
<ignored> 

File position and 
Progress 

Data is processed from beginning to end. This bar shows the number of 
bytes from the file that is already processed. The total file size (in bytes) is 

shown after the slash 

Reload This button can be used to process the file with a different XDA profile. The 
current loading procedure will be cancelled.  

Stop Processing the file will be stopped. Already processed data is available in MT 

Manager 

Cancel Loading the file will be cancelled. Data is not available in MT Manager 

 

Logged data can either be presented at once in a graph or played back in real time. 

These two settings can be chosen via “Tools” → “Preferences...” → MT Manager → Graphs 

→ File Plotting Method: Real-time or All Data 
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Figure 79: The behaviour of the graphs can be adapted in the Preferences - Graphs window 

 

Time options: 

The number of points in the graphs can be chosen in this dialog. When setting the time 

to a higher value, the data in the graphs can be investigated over a long period of time.  

 

The “Play” and “Rewind” buttons can then be used to control the playback (see also 

section 5.7.5): 

 

 
Figure 80: The Playback toolbar 

 

It is recommended to open the desired views before starting the playback. 
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6.4.3 Exporting ASCII data 

Data previously logged into an .MTB file can be exported to the ASCII format. After 

opening an .MTB file, click Export . The Export Configurations window will open. 

 
Figure 81: ASCII exporter settings dialog 

Here the default file name is defined as: 

<inputfile>-<seqnr>-<time>.txt, where 

inputfile is the original name of the logged file 

seqnr is incremented each time the corresponding .MTB file is processed. 
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time is the time read from the system (Windows) clock 

 

You can change the output path in this screen (the output path is the same as the 

“current directory” in MT Manager). The default export file name is displayed in the 

Filename field. You can edit this name before exporting. Press the “Export” button to 

complete the export. Make sure you have writing rights for the specified folder.  

 

 

In the next sub-sections you will find details of the exporter types. 

6.4.3.1 ASCII Exporter – File Name 

The file name can be configured with the following parameters:  

 
Table 27: Parameters that can be chosen to automatically form a file name for the ASCII exporter 

Parameter Description 

<date> Data of export (e.g. 2014-09-28) 

<deviceid> Device ID (e.g. 0360005B) 

<inputfile> Original Filename without extension (e.g. MT0360005B-005) 

<seqnr> Sequential number (e.g. 003). Include <seqnr> or <time> to ensure 
unique output file names 

<productcode> Product code (e.g.MTi-30-2A5G4) 

<scenario> Filter profile used (e.g. general) 

<time> Time read from the system clock. Include <seqnr> or <time> to 
ensure unique output file names 

Any text It is possible to add any text, such as dashes, underscores, but also 
words and digits in the file name format.  

 

 

6.4.3.2 ASCII Exporter – Delimiter Options 

It is possible to choose the delimiter options that can help you to import the columns of 

data of the exported file into an external program. You can also define your own delimiter 

(one character from the extended ASCII table).  

 

 
Figure 82: In the delimiter options, you can even choose your own exotic delimiter, e.g. § or ¼ 

 

6.4.3.3 ASCII Exporter – Empty field options 

As the MTi can export data at different output frequencies per data output, it is required 

to choose the behaviour when data does not exist in one (exported) data package. You 

can choose with which placeholder this field is filled. You can also insert your own string 

(unlimited). The empty field placeholder will help you when importing the data into an 

external program. NaN is commonly used in Excel.  

 



   

 

 

 

 

  

 

75 www.xsens.com 

 
Figure 83: When no data is available in a row, specify your own characters for the empty cell/field 

 

6.4.3.4 ASCII Exporter – Exported data 

The ASCII exporter can export many data quantities. Select those required in the 

Exported Data section.  

 

 

 
 

Figure 84: Options for data export 

6.4.3.5 ASCII Exporter – file format 

The output consists of a header with settings information and the actual data which is 

delimited by the delimiter chosen.  

The following picture shows the first part of an example exported ASCII data file in Excel, 

still as .txt format:  
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Figure 85: Exported ASCII txt file in Excel. Empty fields are filled with NaN (configurable in the 

Preferences window). 

The table below describes the column headers in the ASCII exported file.  

 
Table 28: Overview of all possible exported columns in an ASCII file 

Column header # of col. Unit Description 

Time and date related data 

PacketCounter 1 N/A Packet counter, wraps on 65535 

SampleTimeFine 1 N/A Sample Time of the sensor in ticks of 10 kHz 

(note that data may come in the file 
asynchronous; sample times of rows don’t 
necessarily have to increase). Sample time 
fine is a data packet, and is always 

exported. This means that if the recorded 
file has a higher frequency than the 
exported file (e.g. when you are not 

exporting all data), some rows may seem to 
be empty except for the PacketCounter and 
SampleTimeFine.  

Year 1 N/A Year 

Month 1 N/A Month 

Day 1 N/A Day 

Second 1 s Seconds from the day (midnight starts at 
0.00) 

UTC_Nano 1 ns Nanosecond of second (UTC format, not 
necessarily UTC time) 

UTC_Year 1 N/A Year (yyyy) (UTC format, not necessarily 

UTC time) 

UTC_Month 1 N/A Month of the year (UTC format, not 
necessarily UTC time) 
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UTC_Day 1 N/A Day of the month (UTC format, not 
necessarily UTC time) 

UTC_Hour 1 hours Hour of the day (UTC format, not necessarily 
UTC time) 

UTC_Minute 1 min Minute of the hour (UTC format, not 

necessarily UTC time) 

UTC_Second 1 sec Second of the minute (UTC format, not 
necessarily UTC time) 

UTC_Valid 1 N/A UTC_Valid is 0 when no GPS is used; 

otherwise it adopts UTC_Valid from 
GPSTimeValidity (see below) 

    

Status data 

StatusWord 1 N/A 32-bit status, see [LLCP] for information on 
the Status Word 

ClippingFlags    

RSSI   Received Signal Strength Indicator – used 

for Awinda to determine signal strength of 
MTw wireless communication 

    

Sensors data 

Acc_X / _Y / _Z 3 m/s2 3D acceleration, processed via SDI and 
inverse SDI. 

When exported from SCR data, this data is 
only compensated for bias, temperature, 
gain and misalignment (no SDI and inverse 
SDI) 

FreeAcc_X / _Y / _Z 3 m/s2 3D acceleration, where gravity has been 
subtracted from. Maximum frequency is 400 
Hz 

AccHR_X /_Y / _Z 3 m/s2 3D acceleration at rates up to 1000 Hz. See 
[LLCP] for meaning of the output per device 

Gyr_X / _Y / _Z 3 rad/s 3D rate of turn, processed via SDI and 
inverse SDI. 
When exported from SCR data, this data is 
only compensated for bias, temperature, 
gain, misalignment and g-sensitivity (no SDI 

and inverse SDI) 

GyrHR_X /_Y / _Z 3 rad/s 3D rate of turn at rates up to 1000 Hz. See 
[LLCP] for meaning of the output per device 

Mag_X / _Y / _Z 3 a.u. 3D magnetic field, maximum output rate is 
100 Hz 

When exported from SCR data, data is 
copied from 100 Hz to match output 
frequency 

VelInc_X / _Y / _Z 3 m/s 3D delta_velocity (dv); result of SDI 
algorithm 

OriInc_q# 4 N/A 3D delta_quaternion (dq); result of SDI 
algorithm 

Pressure 1 Pa Static pressure (MTi 100-series only) 

    

Orientation, Position and Velocity (data that is processed by the Xsens fusion filter algorithm) 

Roll / Pitch / Yaw 3 deg Euler angles orientation output 

Quat_q0 / q1 /q2 / q3 4 N/A Quaternion orientation output 
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Mat[#][#] 9 N/A Rotation Matrix orientation output 

Latitude / Longitude 2 deg Decimal representation of latitude and 
longitude – estimated by Xsens fusion filter 
algorithm – MTi-7 and MTi-G-710 only 

Altitude 1 m Altitude above geoid (WGS84 datum) – 

estimated by Xsens fusion filter algorithm – 
MTi-7 and MTi-G-710 only 

Vel_X / _Y / _Z 3 m/s 3D velocity in same coordinate system as 
orientation – estimated by Xsens fusion filter 

algorithm – MTi-7 and MTi-G-710 only 

    

Sensor Component Readout (10-series and 100-series only) 

Temperature 1 ºC Reading of the general temperature sensor, 
located near the accelerometers and 

magnetometer 

GyrTemp_X / _Y / _Z 3 ºC Reading of the gyroscope temperature 
sensor, located inside each individual 
gyroscope 

SCRAcc_X / _Y / _Z 3 N/A Digitized (16-bits) analog readout of the 
accelerometers (bits) 

SCRGyr_X / _Y / _Z 3 N/A Digitized (16-bits) analog readout of the 
gyroscopes (bits) 

SCRMag_X / _Y / _Z 3 N/A Readout (no bias/gain compensation) of 

magnetometer (bits) 

SCRTemperature 1 N/A Readout of the general temperature sensor 
(bits) 

SCRGyrTemp_X / _Y /_Z 3 N/A Readout of the temperature sensors in the 

gyroscopes (bits) 

    

GNSS message (MTi-G-710 only) – composed of 2 distinctive messages that are in exported file 
in different rows 

NUTimeOfWeek 1 ms GPS time of week 

TimeAccuracyEst 1 ns Time accuracy estimate 

GNSS UTC time (GPS) 7 Units 
according 

to 
column 

header 

These 7 columns output the UTC time as 
outputted by the GNSS receiver: 

GNSSNanoSecOfSec, GNSSYear, 
GNSSMonth, GNSSDay, GNSSHour, 

GNSSMin, GNSSSec 
Time is determined by GPS only 

GNSSTimeValidity 1 - Validity flags: 
  bit (0) = UTC Date is valid 

  bit (1) = UTC Time of Day is valid 
  bit (2) = UTC Time of Day has been fully 
resolved (i.e. no seconds uncertainty) 

GNSSFixtype 1 - GNSS fix type (range 0..5): 
  0 = No Fix 

  1 = Dead Reckoning only 
  2 = 2D-Fix 
  3 = 3D-Fix 
  4 = GNSS + dead reckoning combined 
  5 = Time only fix 

GNSSFixStatusFlags 1 - Fix Status Flags: 

  bit (0) = valid fix (within DOP and accuracy 
masks) 
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  bit (1) = differential corrections are applied 
  bit (2..4) = reserved (ignore) 
  bit (5) = heading of vehicle is valid 

NumberOfSV 1 - Number of satellites used in navigation 
solution 

Longitude 1 deg Longitude 

Latitude 1 deg Latitude 

Height 1 mm Height above ellipsoid 

HeightMeanSeaLevel 1 mm Height above mean sea level 

HorizonalAccuracyEst 1 mm Horizontal accuracy estimate 

VerticalAccuracyEst 1 mm Vertical accuracy estimate 

VelocityN/E/D 3 mm/s NED velocity 

GroundSpeed 1 mm/s 2D ground speed 

MotionHeading 1 deg 2D heading of motion 

SpeedAccuracyEst 1 mm/s Speed accuracy estimate 

HeadingAccurayEst 1 deg Heading accuracy estimate (both motion and 
vehicle) 

Heading 1 deg 2D heading of vehicle 

*DOP 7 - DOP values 

    

    

Itow 1 ms GPS time of week 

GnssId[#];SvId[#];Cno[#];Flags[#] 60*4 - GnssId: GNSS identifier 

  0 = GPS 

  1 = SBAS 
  2 = Galileo 
  3 = BeiDou 
  4 = IMES 
  5 = QZSS 
  6 = GLONASS 

 
SvId: Satellite identifier 
 
Cno: Carrier to noise ratio (signal strength) 
 
Flags: 
  bit (0..2) = signal quality indicator 

    0 = no signal 
    1 = searching signal 
    2 = signal acquired 
    3 = signal detected but unusable 
    4 = code locked and time synchronized  
    5, 6, 7 = code & carrier locked; time 
synchronized 

  bit (3) = SV is being used for navigation 
  bit (4..5) = SV health flag 
    0 = unknown 
    1 = healthy  
    2 = unhealthy 
  bit (6) = differential correction data is 

available 
  bit (7) = reserved 
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Triggers (Trigger1 and Trigger2); MTw only, Trigger Indication of MTi can be found in 
StatusWord 

TrigIn1_Polarity 1 N/A Polarity of the signal received: 
1: Rising Edge 
2: Falling Edge 
3: Both 

TrigIn1_Timestamp 1 N/A The time stamp of the trigger 

TrigIn1_Framenumber 1 N/A The frame number in which the trigger was 
received 

TrigIn2_Polarity 1 N/A Polarity of the signal received: 
1: Rising Edge 
2: Falling Edge 
3: Both 

TrigIn2_Timestamp 1 N/A The time stamp of the trigger 

TrigIn2_Framenumber 1 N/A The frame number in which the trigger was 
received 

 

6.4.4 Exporting KMZ data 

It is possible to export data from an MTi-7 or MTi-G-710 to a KMZ file. The KMZ file 

contains geo-referenced data points with corresponding orientation, velocity, GNSS mode 

and times. The contents of the KMZ file can be customized to match the user’s 

preferences. The steps to export a KMZ file are: 

1. Load an MTi-7 or MTi-G-710 file. This file must contain processed orientation and 

position, SCR data (including GNSS PVT data) or data that can be processed with 

XDA.  

2. Set the preferences of the KMZ exporter via Tools-Preferences-Exporters.  

a. Choose a Filename template (see 6.4.3.1).  

b. Choose the maximum numbers of markers per second. The default value is 

1; you should adapt this value to your velocity: too many data points per 

second may cloud the data points in Google Earth.  

3. Export the file via File – Export. You can change the output path and file name 

here.   

The file can now be loaded into e.g. Google Earth.  
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Figure 86: An MTi-G-710 data point in Google Earth 

6.4.5 Using multiple MTis 

Multiple Motion Trackers can be managed with the MT Manager.  
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Figure 87: Managing an MTi-300 (left) and an MTi-7 (right) 

 



   

 

 

 

 

  

 

83 www.xsens.com 

7 System requirements 
The MT Manager is designed for Windows 10 and Linux; the following system setup is 

recommended to properly run the software: 

 

• Windows 10 64-bit or Linux 64-bit (no official support for Windows 7/8 or 32-bit 

platforms) 

• Intel® Pentium® or AMD® processor, 1 GHz (minimum) Pentium® IV 2.00 GHz 

or AMD Athlon® XP 2000+ or higher (recommended) 

• USB port (1.1 or higher) or standard PC serial COM-port (RS-232) 4,5 

• Graphics card with 3D hardware acceleration and OpenGL support. Contact your 

graphics card manufacturer to ensure your graphics card drivers are up to date. 

Recommended screen resolution (height) is 900 pixels or higher.  

 

NOTE: MT Manager is designed to assign a low priority to graphics functions if your 

computer can not update the screen smoothly due to insufficient computing resources. 

This is done on purpose to avoid interfering with the core functionality of the MT 

Manager. 

 

 
4 RS-232 add-on cards are not supported 
5 Custom RS-232 USB converters are not supported 


